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Cisco Jabber and Cisco Finesse

Cisco Jabber and Cisco Finesse together will give you the capability to answer phone
calls for your call center whether you are working onsite or remotely.

What is Cisco Jabber?

Cisco Jabber is an application for Windows that allows you to make and receive calls.
Jabber functions as a virtual phone.

What is Cisco Finesse?

Cisco Finesse is an agent and supervisor desktop available through your web
browser. Finesse connects you to your call center and your call center's phone
queue.
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Working From Home Setup

To begin using Cisco Jabber and Cisco Finesse from home to connect to your call
center, you will first need to install Cisco AnyConnect VPN and Cisco Jabber on your
personal home computer and register your mobile device for multi-factor
authentication. Follow the instructions below.

Microsoft Authenticator

The first-time users remotely login to a UMHW view session, registration in Multi-
Factor Authentication is required. If you have already completed these steps,
continue to Cisco AnyConnect VPN Install

Step 1.

From your mobile device

Obtain the Microsoft
Authenticator App from the App
Store or Google/Android Play
Store. If you already have the
Microsoft Authenticator App,
move to step 2.

Microsoft Authenticator

re yur online identity
% % % % %

More security, for Sign in with your Connect to all
all your accounts phone of Microsoft

& T 0

Step 2:

On Your Computer:
You may be prompted to
pick an account. Pick your
UMHW account or select
“Use another account if you
don’t see your UMHW
account isn’t listed.

UNAVRTTY F MACHIEAN EALTH WEST

Pick an account

—I_ Use another accounit
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Step 3:

Follow the Microsoft Sign In
process.

You must sign in using your
username@umhwest.org

Example —

SmithJJ@umhwest.org

UNIVERSITY OF MICHIGAN HEALTH-WEST

s v

Step 4.
Enter your UMHW network
password and choose “Sign
In”.

UNNERSITY OF MICHIGAN HEALTH-WEST

S e et

& smithjj@umhwest.org
Enter password

Forgot my password

Step 5:
Choose “Next” at the
screen stating more
information is required.

UV TY O MCIGAN LA TS ST
e m

-

smithjj@umhwest.ong

More information required

Your arganization needs maore information to keep

your account sacurs

JS2 a4 QIMTErENt aCCouni
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Step 6:

You will be presented with the
following screen. Please leave the
default settings selected for the
Microsoft Authenticator App.

Select Next.

Start by getting the app

I )]

Laant 10 sef g A QuTarent mathod

Step 7:

You will be presented with the
following screen. Please leave the
default settings selected for the
Microsoft Authenticator App.

Select Next.

Keep your account secure

Your organization requires you to set up the following methods of proving who you are.

Microsoft Authenticator

Set up your account

f prompted, allow notifications. Then add an account, and select “Work or school

Lwant to set up a different method

Step 8:

You will be presented with the similar
screen. Please leave the default
settings selected for the Microsoft
Authenticator App.

Proceed to step 9

**DO NOT HIT NEXT UNTIL
YOU HAVE SUCCESSFULLY
SCANNED YOUR PERSONAL
QR CODE - THIS WILL BE
DETAILED IN STEP 13**

Keep your account secure

ur organization requires you to set up the following methods of proving who you ar

Microsoft Authenticator

[Scan the QR code
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Step 9:

On your mobile device:

Open the Authenticator app on your
mobile device.

** At any point the authenticator
may ask for permissions to send
notifications, please select allow.
This allows the authenticator to
send push notifications for access
approval.

At any point the authenticator may ask
for permissions to access the camera,
please select allow. This allows the
authenticator to use your camera to scan
QR codes **

M\

Microsoft Authenticator - Ap...

Step 10:

Choose +

If you are already using the
Microsoft Authenticator App for
any other accounts, also select the
“+” symbol.

4:33

= Authenticator

Ready to add your first account?

at

Add account
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Step 11:

Choose “Work or school
account”.

Add account

WHAT KIND OF ACCOUNT ARE YOU ADDING?

Personal account

Work or school account

g Other (Geogle, Facebook, etc.)

Step 12:

The notification to scan the
QR code will appear. Select
Scan QR Code.

Add account

WHAT KIND OF ACCOUNT ARE YOU ADDING?

mm "

.. Personal account

Other (Google, Facebaook, etc.) >

Add work or school account

Sign in Scan QR code

Step 13:

Using your mobile device scan
the QR code displayed on

your computer browser using
the authenticator application.

After scanning you should now see

your account populate on the
authenticator application.

Keep your account secure

Your organization requires you to set up the following methods of proving who you are.

Microsoft Authenticator

[Scan the QR code

]

Use the Microsoft Authenticator app to scan the QR code. This will connect the Microsoft Authenticator
app with your account.

After you scan the QR code, choose "Next".

Can't scan image?
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Step 14:

From your view session or onsite
computer

Select Next from the browser
window.

Keep your account secure

Your organization requires you to set up the following methods of proving who you are.

Microsoft Authenticator

[Scan the QR code

l

Use the Microsoft Authenticator app to scan the QR code. This will connect the Microsoft Authenticator

app with your account.

After you scan the QR code, choose "Next".

Step 15:

Microsoft will send an
approval request to your
mobile device to verify the
two-factor authentication
functionality is working as
expected.

Keep your account secure

Your organization requires you to set up the following methods of provi

Microsoft Authenticator

Let's try it out

v/

Approve the notification we're sending to your app.

Lwant to set up a different method

g who you are,

Back

Step 16:
From your mobile device
Open the push notification

received or the authenticator
application.

e Approve sign-in?

now
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Step 17:

From your mobile device

Enter the number displayed
on the computer screen and
select Yes.

Are you trying to sign in?

Metro Health Hospital
smithjj@umhwest.org

Enter the number shown to sign in.

App
view.metrogr.org

Location
MI, United States

*Muskegon
o .
Grand Rapids
Holland, 2t
Lansing,
|Fr*.20r number here
No, it's not me Yes

You may be prompted to scan
Biometrics or enter a Device Pin
depending on the configuration
within the Microsoft Authenticator
App — App Lock settings.

App Lock also helps ensure that
you’re the only one who can
approve notifications by
prompting for your PIN or
biometric any time you approve a
sign-in notification. You can turn
App Lock on or off on the

Authenticator Settings page.

By default, App Lock is turned on
when you set up a PIN or biometric
on your device.
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Step 18:

From your view session or
onsite computer

Once you've approved the
notification, select “Next”.

Keep your account secure

Your organization requires you to set up the following methods of proving who you a

Success!

Great job! You have successfully set up your security info. Choose "Done” to continue signing in.

Default sign-in method:

P
©  Microsoft Authenticator

re.

Step 18:
You will be presented with the

following screen.

Great job! You have successfully
set up your security info.

Keep your account secure

Your organization requires you to set up the following methods of proving who you a

Success!

Great job! You have successfully set up your security info. Choose *Done” to continue signing in.

Default sign-in method:

P
©  Microsoft Authenticator

re.
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Cisco AnyConnect VPN Install

To install Cisco AnyConnect VPN, please follow these steps below on your personal
workstation at home. Do not install or complete steps in a UMHW view session.

1. Download the AnyConnect VPN client software from the UMHW website
https://uofmhealthwest.org/staff-portal/, scroll down to the bottom under Cisco
AnyConnect and click Client Download to download software.

WORK FROM HOME

JABBER VDI PLUGINS
Jabber Client installer 14

CISCO ANYCONNECT

Client Download

2. Once the software has finished downloading, double-click on the installer
package in your downloads folder to begin the installation process.

> ARE = | Downloads - O X
Home Share View 9
e [ Open
dy Ut . _ = Ope Select all
_J ove to X Delete - _L‘J v H
W] Copy path Il- Edit Select none
Pin to Quick Copy Paste _ Copy to Rename Mew Properties i i
3ccess ?] Faste shortcut . folder - % History DDImrert selection

— S -‘ » This PC » Downloads v | & Search Do... @
# Quick access B2, anyconnect-win-core-vpn-webdeploy-k9.exe
“@ OneDrive \ Launch Install Package
3 This PC
¥ Metwork
1 item = &=
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3. Follow the on-screen instructions to install the software. Select Next. You may be
prompted to enter your administrator password if you are installing on a Mac.

ﬁ Cisco AnyConnect Secure Mobility Client Setup *
1=
E =AY Welcome to Cisco
) ‘% 1 AnyConnect Secure
= Mobility Client Setup
. Wizard
The Setup Wizard will install Cisco AnyConinect Secure
Sl w -~ Mobility Client on your computer. Click Next to
R) B continue or Cancel to exit the Setup Wizard,
\
i
(/
A5 l{: J

~
N
o |
=

4. Select | accept the terms in the License Agreement and select Next.

1%] Cisce AnyConnect Secure Mobility Client Setup *
End-User License Agreement ‘
Please read the following license agreement carefully "4
e

Supplemental End User License Agreement .
for AnyConnect® Secure Mobility Client v4.x
and other VPN-related Software

IMPORTANT: READ CAREFULLY
By clicking accept or using the Cisco Technology, you agree that such use is

governed by the Cisco End User License Agreement and the applicable |,

.. tE T

(@)1 accept the terms in the License Agreement
(7)1 do not accept the terms in the License Agreement

Advanced Installer
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5. Select Install to continue and allow any modifications to your device.

JABBER VDI PLUGINS
Mac
ﬂ Cisco AnyCennect Secure Mobility Client Setup *

Ready to Install §
The Setup Wizard is ready to begin the Typical installation

Click "Install” to begin the installation. If you want to review or change any of your
installation settings, dick "Back”™. Click "Cancel” to exit the wizard.

Advanced Installer

<tock [ @il | | Cance

6. When the installation is complete, open the AnyConnect VPN client software
from your start menu.

Calculator

Calendar

¢ Cisco AmyConnect Secure...

Contact Support
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7. In the AnyConnect VPN client window, enter the server address
VPN.METROGR.ORG.

’Sﬂ Cisco AnyConnect Secure Mobility Client = X

r 9 VPN:
% Ready to connect.

VPN.METROGR.ORG

o ® Py
8. Select UOM-WEST-VOICE from the Group drop down window.
'S& Cisco AnyConnect | VPN.METROGR.ORG X

m Please enter your username and password.

Group: UOM-WEST-IT - ‘
UOM-WEST-IT
Username: | jom-WEST-TRAVELERS
Password:
OK Cancel
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9. Single Sign On (SSO) window opens. Enter in your Username@umhwest.org and

Password. Select Sign In. Microsoft Authenticator must be set up to complete the

signin.

mm TY OF MICHIGAN HEALTH WEST

Sign in

I username@umhwest.org I

We're in the process of updating our usernames for
accessing UMHWest resources.

Please use username@umhwest.org moving forward.

Please call the University of Michigan Health-West
Service Desk at 616-252-7378 with any issues.

Q Sign-in options

10. You may receive a Security Alert for site certificate. Select Yes.

Security Alert x

f"ﬂ Revocation information for the security certificate for this site is not
?. available. Do you want to proceed?

Yes No View Certfficate

11. Then select Yes on the web site security alert.

Security Alert x

rir“"l The identity of this web site or the integrity of this connection
?. cannot be verfied.

¢ The securty cerficate was issued by a company you have
= not chosen to trust. View the cerificate to detemine whether
you want to trust the cerifying authority.
@) The security certificate date is valid.

(@) The securiy certfficate has a valid name matching the name
of the page you are trying to view.

¥4 The secunty cerificate uses a strong signature.

Do you want to proceed?

I ‘fes I I No View Certificate
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12. Once connected, you will be able to access resources on the organization's
network as if you were physically located on that network.

@ Cisco AnyConnect Secure Mobility Client

) Ccisco AnyConnect
——
Connected: VPN.METROGR.ORG
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Cisco Jabber Install

To install Cisco Jabber on Windows, please follow these steps below on your

personal computer at home. Do not install or complete steps in a UMHW view
session.

1. Go to the Cisco Jabber download page on the UMHW website.

https://uofmhealthwest.org/staff-portal/ , scroll down to the bottom to Jabber VDI
Plugins. Select Jabber Client installer 14.

WORK FROM HOME

JABBER VDI PLUGINS
Jabber Client installer 14

CISCO ANYCONNECT

Client Download

2. Once the download is complete, double-click on the installer file to start the
installation process.

+ | 1+ = | Downloads - O
Home Share View
& v ; » This PC » Downloads » ~ 0 ' Search Downloads
) MName Date modified Type Size
v g Quick access
. Desktop ~ Today (1)
; . '—Hﬁ! CiscolabberSetup (1) 5/17/2023 2:39 PM Windows Installer ... 163,981 KB

| Documents

| Pictures

@ Onelrive - Persor

~ [ This PC

156 items =] E
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3. Follow the on-screen instructions to install Cisco Jabber on your computer, select

Accept and Install.

‘ﬁ Cisco Jabber

Welcome to the Cisco Jabber for Windows Installer

This will install Cisco Jabber on your Computer
Cisco Jabber is a collaboration application that provides presence, instant
messaging (IM), voice, voice messaging, and video calling capabilities.

IMPORTANT NOTICES AND DISCLATMERS - PLEASE READ

Use of this software is governed by the current Cisco END USER LICENSE
AGREEMENT found at the following link: http: /fwww.cisco.com/fgofeula

By using the Cisco Jabber software without disabling the "Send Usage
Data to Cisco™ option under "Help”™ or "About Cisco Jabber™ , you consent
to Cisco Systems Inc. collection of data from your usage of the Cisco
Jabber software. Cisco does not collect any Personally Identifiable
Information. All Data is collected in conformity with the Cisco Privacy
Palicy which is located at

http: ffwww.cisco.comfweb siteassets flegal fprivacy .himl

By dicking "Accept and Install” on the Installer window you agree to
comply with the terms and conditions of the Cisco EULA. You also consent
to the installation of all future updates of the Cisco Jabber software.

AIADRITRIC s Thic nranram ic tartad ha inht Iz and i i |

-~

Accept and Instal Cancel

4. When the installation is complete, launch Cisco Jabber from your Start menu.

s

- Cisco

- Cisco Jabber

a Cisco Jabber
é‘_: Cisco Jabber Problem Report

0 Clock

Cortana

£ fiype here to search
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5. Enter your Username@metrogr.org and select Continue.

) Cisco Jabber & — 0O

Cisco Jabber

username@example.com

Advanced settings

Continue

6. To authenticate phone services, enter your Username and network Password in
the Cisco Unified Collaboration window. For example: Smithjj, Summer2023. Then

select Login.
&) Cisco Jabber @ — 0O x

il Cisco Unified Collaboration

Username

| Password |

7. Once you are logged in, you can start using Cisco Jabber as a virtual phone.
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How to use Jabber Voice

1. In the bottom left-hand corner, Click on the computer icon.

2. Click on Use my computer for calls

Click on “Use my computer for calls”.

+ [ Use my computer for calls b

% Disable phone services

. Forward calls to 3

3. In the top right -hand corner click on the menu icon and select Settings.

[5]- o x|
File >
Settings
View >
Help »
Sign out
Exit
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4. Click on Audio and select YOUR local audio device or headset.

) Settings

General

I Audio

Video

Calendar
Calls

Status
Location
Motifications
Video Device
Privacy
Accounts

Appearance

Ringer/Alerts

All Devices -

(0 75

Speaker

Speakers-Teradici (Teradici Virtual Audio... ~ a

o 100

Microphone

Microphone (Teradici Virtual Audio Driver) ~

o 82
0

When you connect a new microphone or
speaker to your computer, Jabber will

o Switch to the new microphone or speaker

Keep using the current microphone or speaker

You are now ready to use Jabber as a phone.

Placing a call

1. To place a call. Put in the 4-digit extension for in-house calls and hit return.

[ Q 1234

For outside calls dial 9 in front

of the 10-digit number you are calling and hit return.

| QO 96165551234
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Receiving a call

Calls will appear as a pop-up. You can either click to Answer, Chat reply or Decline
the call.

5) Incoming call

. ==

Playing voicemail
With Cisco Jabber, there is a voicemail capability. Please note that everyone does not have this

feature. The following are steps to access your voicemail if you are set up to receive voicemail.
*Not all users will have Voicemail access.

1. Click on the voice mail icon

| —
o WIRELESS CALLER
Ea 0:36
W 9492738000
0:34
9492738000
0:28
(5]

ol

e — | 9492738000
Voicema i
0:29

2. Click on the play icon to play a message, pause, etc.

UNIVERSITY OF MICHIGAN HEALTH-WEST
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. Right click on the voice mail caller to delete

9492738000

8 All ~
WIRELESS CALLER
D 236
9492738000
a8 34
% 9492738000
)28
e

Rheumatology Check-In

CURBELL, INC. -
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Connect to Cisco Finesse

After connecting to VPN and logging into Cisco Jabber, you can use Cisco Finesse.

1. From an internet browser on your personal workstation at home (not in your view
session), navigate to Cisco Finesse. You can do this now by clicking the link in this
document here=> Sign in to Cisco Finesse (metrogr.org)

*Select the Star to add this website as a favorite for your browser.

w _
Wy Sign in to Cisco Finesse *® +

C O 8 ipccl.metrogr.org:8445/desktop/logon.htmi?locale=en_US |_-7>

2. Log in with your username, password and your four-digit assigned agent
extension.

Cisco Finesse

You are now ready to make and receive calls for your call center while working
remotely.

‘ UNIVERSITY OF MICHIGAN HEALTH-WEST
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Connect to a Remote View Session

Now that you are connected to a VPN and are signed into Cisco jabber and Cisco
Finesse on your workstation at home, connect to a View Session. When working
from home you will utilize a view session specifically set up for optimal performance.

1. Navigate to view.metrogr.org. Select HTML access or download the full client
to your desktop.

' |

L
A

VMware Horizon

You can connect to your desktop and applications
by using the VMware Horizon Client or through the
browser.

The VMware Horizon Client offers better
performance and features.

nstall ViMware VMware Horizon
Horizon Client HTML Access

L Check herst
and always uze HTML £ S5,

2. Enter your network username and password. Select Login.

‘ UNIVERSITY OF MICHIGAN HEALTH-WEST
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Complete Microsoft Authenticator steps.
a. Approve sign in request window opens on the computer.

Approve sign in request

g Open your Authenticator app. and enter the
number Shown 1o Sagn in.

your app? Make sure to wpgrade to

accessing UMHWest rescurces.
Please use username@umhwest.org moving forward.

Please call the University of Michigan Health-West
Service Desk at 616-252-T378 with any issues.

b. Select your Authenticator app or open from the push notification on
your mobile phone.

c. Enter the number from your computer screen and select Yes if
appropriate.

Are you trying to signin?

Metro Health Hospital
s @metrogr.org

Enter the number shown to sign in.

App

view.metrogr.org

Location
MI, United States

*Muskegon

°Grand Rapids

Holland, Lonaast
No, it's not me Yes

1 2 3
ABC DEF

4 5 6
GHI JKL MNO
7 8 9
PQRS Tuv WXYZ
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4. Select View Session named WFH AnyConnect.

£ Horizon | a searn w & 0O 06

WINDOWS 10 WFH
AnyConnect

5. The view session will be used for access to EPIC, WebexWest, and Outlook.
Utilize your home workstation for Cisco Jabber and Finesse to make and
receive phone calls.
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Working Onsite Setup

Connect to a View Session or Desktop

1. Login to the workstation using your network credentials (Username, Password).

2. Select Windows 10 View pool. Do not select the WFH AnyConnect view pool
when working onsite.

T Horizon | Q Searn | w 8 0 b

WINDOWS 10 WFH
AnyConnect

‘ UNIVERSITY OF MICHIGAN HEALTH-WEST

MICHIGAN MEDICINE
28



Login to Cisco Jabber

labber

1. From the desktop, select Jabber.
Enter your username@metrogr.org, select continue.

N

3. To authenticate phone services, enter your Username and network Password

in the Cisco Unified Collaboration window. For example: Smithjj,

Cisco Jabber

username@example.com

Advanced settings

Continue

Summer2023. Then select Login.

&) Cisco Jabber s — O %

Cisco Unified Collaboration

Username

| Password |

4. Once you are logged in, you can start using Cisco Jabber as a virtual phone.
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How to use Jabber Voice

1. In the bottom left-hand corner, Click on the computer Icon.

2. Click on Use my computer for calls

Click on “Use my computer for calls”.

+ [ Use my computer for calls b

% Disable phone services

. Forward calls to 3

3. In the top right -hand corner click on the menu icon and select Settings.

[5]- o x|
File >
Settings
View >
Help »
Sign out
Exit
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4. Click on Audio and select YOUR local audio device or headset.

) Settings

General

I Audio

Video

Calendar
Calls

Status
Location
Motifications
Video Device
Privacy
Accounts

Appearance

Ringer/Alerts

All Devices -

(0 75

Speaker

Speakers-Teradici (Teradici Virtual Audio... ~ a

o 100

Microphone

Microphone (Teradici Virtual Audio Driver) ~

o g2
0

When you connect a new microphone or
speaker to your computer, Jabber will

o Switch to the new microphone or speaker

Keep using the current microphone or speaker

You are now ready to use Jabber as a phone.

UNIVERSITY OF MICHIGAN HEALTH-WEST

MICHIGAN MEDICINE

31



Placing a call

1. To place a call. Put in the 4-digit extension for in-house calls and hit return.

Q 1234

For outside calls dial 9 in front of the 10-digit number you are calling and hit return.

) 96165551234

Receiving a call
Calls will appear as a pop-up. You can either click to Answer, Chat reply or Decline
the call.

) Incoming call X

. e
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Playing voicemail
With Cisco Jabber, there is a voicemail capability. Please note that everyone does not have this

feature. The following are steps to access your voicemail if you are set up to receive voicemail.
*Not all users will have Voicemail access.

1. Click on the voicemail icon

(

WIRELESS CALLER

0:36

£ B

9492738000
9492738000
0:28
e

— 7| 9492738000
volcema
.29

2. Click on the play icon to play a message, pause, etc.

3. Right click on the voicemail caller to delete

O b

B £ B

All ~

WIRELESS CALLER
9492738000
9492738000
9492738000
Rheumatology Check-In

CURBELL, INC. -

(>3

(>3
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Connect to Cisco Finesse

After logging into Cisco Jabber, you can use Cisco Finesse.

1. Open Cisco Finesse application following one of the methods below. §& @
a. Select Cisco Finesse from your desktop -
b. Or you can do this now by clicking the link in this document here—> Sign
in to Cisco Finesse (metrogr.org)
*Select the Star to add this website as a favorite for your browser.

s Sign in to Cisco Finesse x +

CcC O 8 ipccl.metrogr.org:8445/desktop/logon.htmli?locale=en_US |j>

2. Log in with your username, password and your four-digit assigned agent
extension.

Cisco Finesse

You are now ready to make and receive calls for your call center.
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